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1 ЭКСПЕРИМЕНТАЛЬНОЕ ОПРЕДЕЛЕНИЕ СРЕДНЕГО ЗНАЧЕНИЯ 

ПОКАЗАТЕЛЯ ПОЛИТРОПЫ И РАБОТЫ ПРОЦЕССА СЖАТИЯ 

Цель лабораторной работы: исследование политропного процесса 

сжатия газа в цилиндре. 

Порядок выполнения лабораторной работы: 

1) определить среднее значения показателя политропы процесса сжатия 

газа; 

2) оценить величину механической работы, затрачиваемой при сжатии; 

3) составить отчет по выполненному исследованию. 

1.1 Теоретические основы исследования 

Политропные процессы 

Совокупность изменений, происходящих в рабочем теле при конечном 

переходе из одного состояния в другое, называется процессом изменения 

состояния. Между начальным и конечным состояниями рабочего тела 

существует бесконечное множество различных путей перехода, совокупность 

которых аналитически описать невозможно. Поэтому термодинамика 

рассматривает только определенный круг процессов, называемых 

политропными. Они могут быть описаны аналитически. 

Все остальное множество процессов при необходимости расчета 

условно представляется в виде соответствующих политропных процессов с 

такими же начальными и конечными состояниями и с таким же 

энергетическим обменом с окружающей средой. Это особенно часто 

практикуется при исследовании действительных циклов тепловых машин. 

Основной характеристикой, выделяющей политропные процессы из всего 

многообразия процессов изменения состояния термодинамических тел, 

является постоянство отношения приращения внутренней энергии ко всему 

подведенному теплу, что равнозначно выражению с = const. 

Таким образом, политропный процесс характеризуется произвольной, но 

постоянной теплоемкостью процесса. 



1. Уравнение политропных процессов. Используя для произвольного 

политропного процесса уравнение первого начала термодинамики в 

дифференциальной форме для 1 килограмма газа 
v

d q cd T c d T p d v   , 

уравнение состояния pυ=RT и вводя величину 

p

v

c c
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



,   (1) 

называемую показателем политропы, можно получить уравнение 

политропного процесса в виде 

.
n

p v co n s t   (2) 

2. Работа в политропном процессе. Дифференциальное выражение 

работы расширения 1 килограмма газа в любом процессе имеет вид dl=pdυ. 

Работу расширения в некотором процессе от состояния 1 до состояния 2 

можно представить в виде уравнения 

2
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Используя уравнение политропы (2) и интегрируя (3), получим формулу 

для определения работы расширения газа 
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  (4) 

Результат расчета со знаком минус по формуле (4) соответствует 

процессу сжатия. 

3. Теплоемкость газа в политропном процессе. Решим уравнение (1) 

относительно с и введем в него величину /
p v

k c c  - показатель изоэнтропы. 

В результате получим следующее выражение для теплоемкости 

политропного процесса: 

1
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Таким образом, условие постоянства теплоемкости в политропном 

процессе не ограничивает ее численного значения, поэтому число 

политропных процессов бесконечно. 

4. Частные случаи политропных процессов. Из бесконечного множества 

политропных процессов можно выделить группу, имеющую дополнительные 

ограничения. Это изохорный, изобарный, изотермический и изоэнтропный 

(адиабатный) процессы. 

Изохорный процесс протекает при постоянном объеме: υ=const. Для него 

из (1), (2) и (4) следует, что n=±∞; c=cυ, l1-2=0. 

Изобарный процесс - при постоянном давлении: р=const. Для него из тех 

же соотношений следует, что n=0; c=cp и l1-2=(υ2-υ1)∙p. 

Изотермический процесс - при постоянной температуре: Т=const или 

pυ=const. Для него получим n=1; c=∞, а работа, согласно (3), равна 
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Изоэнтропный процесс протекает без теплообмена с окружающей 

средой: dq=0. Выражая тепло через теплоемкость процесса, получим dq=cdT. 

А так как в этом процессе dT≠0, то с=0, и, следовательно, из (1) получим 

.
p
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c
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c
   

Тогда уравнение изоэнтропного процесса можно записать так: pυk=const, 

а работа за процесс, согласно (4), запишется в виде 
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5. Определение показателя политропы процесса. Запишем уравнение 

политропы для двух конечных состояний 

1 1 2 2
.

n n
p v p v  

Прологарифмируем и преобразуем полученное выражение: 
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Из последнего получаем значение показателя политропы: 

1 2
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p p
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v v
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
  (5) 

Таким образом, для любого политропного процесса имеет место 

постоянство отношения разности логарифмов величин абсолютных давлений 

к разности логарифмов объемов в начальной и конечной точках процесса. 

Значит, при построении в логарифмических координатах (lgp-lgυ) любой 

политропный процесс имеет вид прямой (рис. 1), причем тангенс угла 

наклона ее к оси абсцисс численно равен величине показателя политропы. 

Рис. 2 иллюстрирует (на pυ-диаграмме) расположение политропных 

процессов, выходящих из одной и той же точки, в зависимости от величины 

показателя n. 

 

Рисунок 1 – Политропа в координатах lgp-lgν 



 

Рисунок 2 – Политропные процессы в координатах pυ 

1.2 Описание лабораторной установки 

На рис. 3 приведена схема лабораторной установки для исследования 

процесса политропного сжатия газа (воздуха). В состав установки входят 

следующие агрегаты. 

Цилиндр 1 (двойного действия) с поршнем 2, делящим полость 

цилиндра на рабочую А и приводную Б; шток 3, на конце которого закреплен 

подвижный столик 4 с бумагой для записи графика; графопостроитель, 

включающий в себя систему рычагов 5 с карандашом и пневмопривод с 

пружиной 6 и поршеньком 7. Установка имеет пневмоэлектропульт 

управления 8 и баллон для сжатого воздуха 9 для привода поршня 2 в 

движение, а также два манометра: 10 - для контроля давления сжимаемого 

газа и 11 - для контроля давления в сети пневмопривода. На 

пневмоэлектропульте установки размещены вентили 12, 13, 14, 15, 16 для 

управления работой установки и группа сигнальных ламп, кнопок, тумблеров 

включения электроклапана и электромагнитного вибратора, который 

присоединен к графопостроителю с целью уменьшения влияния на точность 

записи параметров процесса сил трения в рычажной системе. Электроклапан 

позволяет подать воздух в полость Б с большой скоростью. 



 

 

 

Рисунок 3 – Схема экспериментальной установки



1.3 Выполнение эксперимента и обработка его результатов 

Убедиться, что все вентили пневмопульта установки закрыты. Открыть 

вентиль 13 и по манометру 11 определить давление воздуха Рmax в сети (в 

баллоне 9), записать в протокол измерений. На щитке тумблером включить 

электропитание установки постоянным и переменным напряжением 

(загорятся все сигнальные лампы). Закрыть вентиль 13 и еще раз убедиться, 

что все вентили закрыты. 

Чтобы подготовить установку для политропного сжатия газа (воздуха) в 

полости А цилиндра 1, необходимо переместить поршень 2 в крайнее левое 

положение. Для этого надо открыть дренажный вентиль 14, и, плавно 

открывая вентиль 16, подать воздух в полость А, в результате чего поршень 2 

будет перемещаться влево до упора (слышен характерный звук удара). 

Закрыв вентиль 16, открыть дренажный вентиль 15 для выравнивания 

давления в полости А с атмосферным, контролируя падение давления в 

полости по манометру 10. После небольшой выдержки (30...40 с) закрыть 

вентиль 15. Еще раз проверить, что все вентили закрыты.  

Установить на столик 4 лист бумаги, вырезанный по формату столика, и 

закрепить его. Поджать пружинкой карандаш графопостроителя к листу и 

включить тумблером электромагнитный вибратор. Нажатием кнопки на 

пульте открыть электроклапан, подающий воздух из баллона 9 в полость Б 

цилиндра 1. Вместо включения электроклапана можно быстро открыть 

вентиль 13, что тоже позволит подать сжатый воздух в полость Б. В любом 

случае поршень 2 начнет перемещаться вправо, осуществляя тем самым 

сжатие порции газа (воздуха), заключенной в полости А. По манометру 10 

визуально фиксируется изменение давления (рост его), а графопостроителем 

через поршень 7, систему рычагов 5 на бумаге, перемещающейся со 

столиком и штоком, записывается кривая pυn=const. Сразу после 

прекращения движения поршня на графике фиксируем точку р2n (см. рис. 4), 

а в протокол записываем давление по манометру 10. 



 

Рисунок 4 - Изменение давления pυn=const 

Сделав выдержку по времени для достижения термического равновесия 

системы (остывание сжатого газа), фиксируем точку р2T и записываем 

давление по манометру 10. 

Далее осуществляем изотермическое расширение газа, сжатого в 

полости А, плавно открываем дренажный вентиль 14, медленно стравливая 

воздух из полости Б. Под действием сжатого газа (воздуха) в полости А 

поршень пойдет в крайнее левое положение, а карандаш графопостроителя 

должен возвратиться в точку 1 (рис. 4), построив кривую процесса Т=const. 

Воздух из полости Б необходимо стравливать не сразу, а постепенно, 

прикрывая вентиль 14 каждые 105 Па (по манометру 10) и фиксируя точками 

положение карандаша на бумаге после небольшой выдержки системы. 

Значения давлений в полости А записываем в протокол наблюдений. 

Затем необходимо проверить тарировку пружины 6 графопостроителя, 

для чего после завершения изотермического расширения, открывая вентиль 

16, повышаем давление в полости А до рmax, отмечая на графике положение 

карандаша через каждые 105 Па (точки а, b, с, d). Напоминаем, что включение 

вибратора в процессе изотермического расширения и тарировки обязательно. 



1.4 Обработка результатов опыта 

Полученную на графопостроителе диаграмму сжатия и расширения газа 

в полости А необходимо перестроить в p-V координатах. Предварительно 

определяем величину X - расстояние между торцовой стенкой цилиндра и 

поршнем (см. рис. 3), находящимся в крайнем правом положении. Это 

позволит учесть влияние на процессы сжатия и расширения газа, 

заключенного в этом объеме. Строго говоря, следовало бы учесть также 

объем и массу газа, находящегося в трубопроводе, манометрической трубке, 

в полости поршня графопостроителя, но влияние этих величин будет 

незначительным. Объем газа в полости X равен 

,
x п

V X F   

где 
4

2

n
D

F


  - площадь поршня, м2. (Dn=0,13 м). 

Значение X находим из уравнения Бойля-Мариотта: 

1 1 2
,

T x
p V p V  

но 

 1
,

x h T T п
V V V X h F      

где hT - ход поршня при  изотермическом  расширении (рис. 4), 

определяемый из графика. 

Тогда 

 1 2п T T п
p F X h p F X     

или 

1 1 2
,

T T
p X p h p X      

откуда 

 

1

2 1

.T

T

p h
X

p p



 

Определив значения V1, Vx, VhT, Vn, строим в принятых масштабах μp и μυ 

диаграмму процессов сжатия и расширения, используя значения абсолютных 

давлений р1, p2 T и p2n и промежуточных абсолютных давлений, снимаемых с 



графика рис. 4 (или записанных в протоколе наблюдений) для точек II, III, 

IV, V, а - также VI, VII и VIII. 

Согласно (2), запишем равенство 
1 1 2 2

n n

п п
p v p V , которое в соответствии с 

(5) позволяет найти среднее значение показателя политропы процесса 

сжатия: 

2 1

1 2

lg lg
.

lg lg

п

п

p p
n

V V





 

При аккуратном проведении опыта и построении диаграммы р-V 

значение n для изотермы расширения равно 

2 1

1

1
lg lg

.
lg lg

T

x

p p
n

V V


 

  

По значениям давлений и объемов в начальной и конечной точках 

процесса и одной промежуточной строим график политропного процесса в 

координатах lg p-lg V (рис. 1). 

Работу сжатия газа (в Дж) находим по выражению (4), учитывая, что 

сжимался не 1 кг газа, а некоторое его количество (в кг). 

1
,m V    

где 

   

2

1 1

4
.п

T п T

D
m X h F X h


       

Следовательно, для политропного процесса 

 
 1 1 2 2

1

1
.

п п
L p V p V

n
  


 

Для изотермического: 1

1

2

ln .

T

p
L m R T

p
  

Полученное значение работы сжатия и расширения сравниваем со 

значением её, определяемым из диаграммы р—V. Площадь, заключенная под 

кривой процесса сжатия 1-2n ординатами и абсциссой V, должна быть 



численно равна работе сжатия и определяется подсчетом клеток. Площадь 

каждой клетки, 
2
:

H м

д е л


 

,
к л p v

f    

где μp - линейный масштаб от давлений, 
2

;
H

м д е л
 

 μυ - линейный  масштаб от объемов, 
3

.
м

д е л
 

Площадь под кривой процесса, Н·м: 

,
п р о ц е с с а к л

F f N   

где N - число клеток, принятых за единицу масштаба. 

Аналогичный расчет проводим для процесса расширения. Результаты 

измерений и расчетов в ходе проведения лабораторной работы заносятся в 

протокол испытаний, представленный в виде таблицы. 

Таблица 1 - Протокол записи измерений 

Процесс Политропа Изотерма 

№ точки 

параметра 
I II III IV V 2n 2T VI VII VIII l 

pизб, Па            

pабс, Па            

h, м            

V, м3            

n            

m, кг            

lтеор, Дж/кг            

μp, Дж/кг∙дел            

μυ, м
2/дел            

N, дел2            

lграф, Дж/кг            

Δl, %            

 

 



1.5 Содержание отчёта 

1. Принципиальная схема и описание установки. 

2. Протокол эксперимента. 

3. Диаграмма р—V сжатия и расширения. 

4. Расчеты значений X, n, l и других величин. 

1.6 Контрольные вопросы 

1. Дайте определение политропного процесса. 

2. Как различить между собой процесс политропный и не политропный. 

3. Какова должна быть скорость перемещения поршня для реализации 

изотермического, адиабатного процессов. 

4. Каким образом при проведении эксперимента достигается 

приближение процесса к изотермическому? 

5. Что означает бесконечно большое значение теплоёмкости в 

изотермическом процессе? 

6. Запишите первое начало термодинамики для изопроцессов. 

7. Сформулируйте основное свойство p v  координат. 

8. Как доказать, что адиабата, имеющая с изотермой общую точку 

пересечения, расположена круче. 

9. Проанализируйте как влияет значение показателя политропы на 

перераспределение энергии в различных группах политропных процессов: 

1) 0 1n ; 

2) 1 n k ; 

3) k n  . 

  



2 РАСЧЕТ ПРОЦЕССА СЖАТИЯ ГАЗА 

В ПРОГРАММНОМ ПАКЕТЕ FLUENT 

2.1 Создание расчетной модели 

2.1.1 Запуск программы Gambit и ее особенности 

Построение расчетной модели осуществляется в программе Gambit. Ее 

запуск осуществляется нажатием на соответствующий ярлык на рабочем 

столе или из меню «Пуск» ОС «Windows»: 

Пуск → Все программы → Fluent Inc Products → Gambit 2.4.6 

В результате этого действия появится окно, изображенное на рисунке 5. 

В нём в поле Working Directory необходимо выбрать папку, в которой будут 

сохраняться модели в данной сессии. После этого следует нажать кнопку 

Run. Это приведет к появлению окна программы ANSYS Gambit. Оно 

показано на рисунке 6. 

 

Рисунок 5 – Стартовое окно программы ANSYS Gambit 

 

Рисунок 6 – Окно программы ANSYS Gambit 



2.1.2 Задание имени модели 

Для определения имени модели в верхнем меню нужно выбрать 

следующие пункты: 

File → New. 

Появится диалоговое окно, изображенное на рисунке 7. 

 

Рисунок 7 – Меню создания новых моделей 

- В графе ID набирается имя модели латинскими буквами (например, 

MODEL 1). 

- Выбор имени подтверждается нажатием кнопки «Accept». 

После этого действия появится окно, уточняющее согласен ли 

пользователь закрыть предыдущую сессию. В нем следует нажать кнопку 

«Yes». После этого в верхнем левом углу окна программы появится 

выбранное имя модели. 

2.1.3 Назначение программы, в которой будет происходить решение 

рассматриваемой задачи 

От этого выбора зависит набор доступных граничных условий. В данной 

лабораторной работе расчет характеристик будет происходить в программе 

ANSYS Fluent. Поэтому в верхнем меню следует выбрать: 

Solver → Fluent 5/6. 

На первом этапе построения модели будут построены точки контура 

модели, известные из размеров экспериментальной установки. Затем на их 

базе будут получены границы расчетной области с помощью отрезков, 

которые станут основой для создания поверхностей двухмерной расчетной 

модели. 



2.1.4 Построение базовых точек 

Меню построения точек по координатам (рисунок 8) вызывается в 

главном меню с помощью команды: 

Geometry 

(Геометрия)  
→ 

Vertex 

(Точка)  
→ 

Create 

vertex 

(Создание 

точки) 

 

 

Рисунок 8 – Меню построения точек по координатам 

В появившемся меню в поле Global (в глобальной системе координат) 

следует ввести координату требуемой точки, например, (0; 0; 0). 

Подтверждается построение точки нажатием кнопки Apply. Аналогичным 

образом следует ввести все точки из таблицы 2 координат профиля модели, 

учитывая, что задача двухмерная и координаты по оси Z равны 0. 

Таблица 2 – Координаты точек профиля модели 

Номер точки № Координата X, мм Координата Y, мм Координата Z, мм 

1 0 0 0 

2 140 0 0 

3 140 130 0 

4 0 130 0 

В случае совершения ошибки, действие можно отменить с помощью 

кнопки  («отмена»). Увидеть все построенные точки можно с помощью 

кнопки  («вписать в экран»). Результат построения изображен на 

рисунке 9. 



 

Рисунок 9 – Построение базовых точек профиля 

2.1.5 Построение контура профиля цилиндра 

Профиль модели образован четырьмя отрезками. Для построения 

отрезков нужно вызвать соответствующее меню (рисунок 10) командой: 

Geometry 

(Геометрия)  
→ 

Edge 

(линия)  
→ 

Create 

edge 

(Создание 

линии) 

 

Для построения контура необходимо с помощью левой клавиши мыши и 

нажатой клавишей Shift выбрать соответствующие точки, которые хотите 

соединить. Для принятия действия нужно нажать кнопку Apply. Результат 

действия показан на рисунке 10. 



 

Рисунок 10 – Построение контура профиля модели 

2.1.6 Удаление лишних элементов 

В случае необходимости удалить отрезок или точку откройте следующее 

меню: 

- удаление лини 

Geometry 

(Геометрия)  
→ 

Edge 

(линия)  
→ 

Delete 

edge 

(Удаление 

линии) 

 

- удаление точки 

Geometry 

(Геометрия)  
→ 

Vertex 

(точка)  

→ 

Delete 

vertex 

(Удаление 

точки) 

 



2.1.7 Построение поверхности 

Основой для построения конечно-элементной сетки двухмерной модели 

является поверхность. Она строится с помощью меню построения 

поверхности (рисунок 11): 

Geometry 

(Геометрия)  
→ 

Face 

(поверхность)  
→ 

Form face 

(Создание 

поверхности) 
 

В появившемся меню необходимо поставить курсор в окно Edges и с 

помощью мыши выбирать линии, образующие замкнутый контур расчетной 

области. Для построения поверхности следует нажать кнопку Apply. В 

результате линии контура модели поменяют цвет. 

 

Рисунок 11 – Меню построения поверхности по линии 

2.1.8 Просмотр построенной модели в виде «твердого тела» 

Для того чтобы убедиться, что операция построения поверхностей или 

объемов прошла удачно, необходимо скрыть невидимые линии. Для этого 

нужно нажать кнопку  в меню управления видами (рисунок 12). 



 

Рисунок 12 – Результат построения поверхности 

Для того чтобы вновь увидеть модель в виде каркаса следует щелкнуть 

на той же кнопке правой клавишей мыши и выбрать . 

2.1.9 Указание граничных поверхностей 

В программе Gambit осуществляется предварительное указание линий и 

поверхностей расчетной области, к которым будут приложены граничные 

условия. Численные значения граничных условий задаются в программе 

Fluent. Поверхности, которые не будут указаны как граничные, по 

умолчанию считаются стенками (Wall) и к ним применяется 

соответствующее граничное условие стенки. Указанный в программе Gambit 

тип граничного условия в случае ошибок или изменения стратегии решения 

можно поменять во Fluent. 

Для выхода в меню задания граничных условий (рисунок 13) следует 

нажать следующие кнопки в главном меню: 

Zones 

(Зоны)  
→ 

Specify Boundary Types 

(Задать тип граничных 

условий) 

 



На рисунке 13 указаны названия линий, к которым применены 

граничные условия: слева – PISTON; отрезки сверху и снизу – STENKA; 

справа – DNO. 

 

Рисунок 13 – Меню задания граничных условий 

Для определения границы поршня необходимо, выбрав ее, произвести 

следующие действия: 

- в поле Action необходимо нажать кнопку Add. Это действие укажет на 

то, что будет задана новая граничная поверхность; 

- в графе Name можно задать наименование граничного условия 

латинскими буквами. Если поле оставить пустым, то имя будет назначено 

автоматически в соответствии с типом граничного условия; 

- нажать кнопки Show labels и Show colors. В результате в окне 

построения созданные граничные условия будут подписываться и выделяться 

цветом; 

- щелкнуть мышью по кнопке Type. В результате откроется доступ к 

списку доступных граничных условий. Содержание списка зависит от 

расчетной программы, которая была выбрана в начале построения модели. В 



данной решаемой задаче типы граничных условий одинаковы и выбираются 

типом Wall; 

- поскольку решаемая задача двухмерная, то граничные условия будут 

задаваться на линиях. Для того, чтобы определить это, необходимо щелкнуть 

мышью на кнопке в области Entity и в появившемся списке выбрать Edge; 

- поставить курсор в поле напротив кнопки Edge и с помощью мыши 

выбрать границу расчетной области. Если произошла ошибка, то удалить 

линию из списка можно, нажав кнопку Remove; 

- выбранные настройки границы подтверждаются нажатием кнопки 

Apply. 

В результате выполнения команды в списке в верхней части меню 

появится название созданного граничного условия, а в области построения 

оно будет выделено цветом и высветится его имя. 

Аналогично задаются граничные условия и названия на других 

поверхностях. 

Результат построения граничных условий показан на рисунке 14. 

 

Рисунок 14- Результат построения граничных условий 

2.1.10 Построение конечно-элементной сетки 

В программном комплексе Fluent есть возможность разбивать 

расчетную область, как на четырехугольные, так и на треугольные элементы. 



Конечно-элементная сетка может быть структурированной или 

неструктурированной (сетка на базе треугольных элементов только 

неструктурированная). Структурированная сетка позволяет получать более 

точные решения, однако она сложнее в построении, особенно для моделей со 

сложной пространственной формой. Время построения такой сетки может 

достигать 80% времени работы над задачей. Неструктурированное разбиение 

проводится легко, однако за это приходится платить ухудшением точности 

расчета. 

Разбиение поверхности осуществляется с помощью команды: 

Mesh 

(Сетка)  
→ 

Face 

(поверхность)  
→ 

Mesh face 

(Разбить 

поверхность) 

 

В результате появится меню, изображенное на рисунке 15. В нем 

следует провести следующие манипуляции: 

 

Рисунок 15 – Меню разбиения поверхности 

- в поле Face надо выбрать поверхности, которые будут разбиваться; 



- в поле Elements выбирается тип конечного элемента Quad 

(четырехугольный), Tri (треугольный) или Quad/Tri (смешанный); 

-в поле Type выбирается схема, по которой производится разбиение. 

Схемы Submap, Map используются для структурированной сетки, схема Pave 

– для неструктурированной. При решении рассматриваемой задачи следует 

оставить схему выбранную по умолчанию (схему Map); 

- в поле Spacing вводится требуемый размер конечного элемента 

(например, 2 мм). 

Для построения конечно-элементной сетки с выбранными параметрами 

нужно нажать кнопку Apply. 

Результат построения упорядоченной четырехугольной сетки приведен 

на рисунке 16. 

 

Рисунок 16 - Результат построения четырехугольной неструктурированной 

конечно-элементной сетки 

2.1.11 Передача построенной расчетной модели во Fluent 

Для экспорта созданной модели в верхнем меню нужно выбрать 

следующие пункты:  

File → Export → Mesh. 



В появившемся окне нужно ввести имя файла обмена. По умолчанию 

оно совпадает с именем файла модели (например, MODEL 1.msh). С 

помощью кнопки Browse можно выбрать место, где файл необходимо 

сохранить. Поскольку расчетная модель двухмерная, то обязательно следует 

нажать кнопку Export 2D (X-Y) Mesh. Запись файла обмена подтверждается 

нажатием кнопки Accept. Если файл обмена был успешно записан, то в окне 

сообщений появится надпись Mesh was successfully written to <имя 

файла>.msh. 

В указанном месте появится файл <имя файла>.msh. 

2.1.12 Сохранение модели Gambit 

Сохранение модели Gambit для редактирования или каких-то других 

действий производится с помощью команды: 

File → Save. 

2.1.13 Закрытие программы Gambit 

Закрытие программы Gambit осуществляется командой: 

File → Exit. 

Перед закрытием программы появится окно, предлагающее сохранить 

модель. Для того чтобы это сделать, нужно нажать Yes. В противном случае 

нужно нажать No. 

Закрытие окна программы стандартным образом в ОС «Windows» с 

помощью крестика в правом верхнем углу не всегда проходит корректно и 

этим способом пользоваться не стоит. 

2.2 Запуск программы Fluent и ее особенности 

Дальнейшие действия с расчетной моделью: задание граничных 

условий, настройка параметров решателя, решение и обработка результатов 

производится в программе Fluent. 



Запуск программы осуществляется нажатием на соответствующий 

ярлык на рабочем столе или из меню «Пуск» ОС «Windows»: 

Пуск → Все программы → ANSYS → Fluid Dynamics → Fluent. 

Перед открытием рабочего окна программы появится меню 

(рисунок 17), предлагающее выбрать тип решаемой задачи из четырех 

предложенных вариантов: 

2D– двухмерная; 

3D – трехмерная. 

В рассматриваемом случае задача является двухмерной. После выбора 

нужно нажать кнопку Ok. Это действие вызовет появление рабочего окна 

программы Fluent (рисунок 18). 

 

Рисунок 17 – Меню выбора размерности задачи 



 

Рисунок 18 – Окно программы Fluent 

Окно программы достаточно простое и состоит из трех основных 

элементов: 

- главного меню, через которое осуществляется доступ ко всем командам 

и меню программы; 

- окна сообщений, где находится командная строка и отображаются 

результаты выполнения команд; 

- графических окон, в которых отображаются результаты расчета и 

построений. Число графических окон может быть любым, но удобнее 

использовать не более трех. 

2.2.1 Чтение расчетной модели, созданной в программе Gambit 

Чтобы прочитать созданную расчетную модель, необходимо в главном 

меню выбрать: 

File → Read → Mesh. 

В появившемся стандартном окне проводника ОС «Windows» нужно 

найти место, где был сохранен файл обмена, выбрать его и подтвердить 

выбор кнопкой OK. 



При чтении файла в окне сообщений Fluent появятся полные сведения о 

модели, содержащейся в читаемом файле: размеры, количество и тип 

конечных элементов и т.п. 

2.2.2 Проверка конечно-элементной сетки на наличие ошибок 

Проверка расчетной сетки на наличие ошибок осуществляется с 

помощью команды: 

Mesh → Check. 

После ее запуска программа начнет проверять конечно-элементную 

сетку, а в окне сообщения появятся полные сведения о конечно-элементной 

сетке. Если будет найдена ошибка, то будет выдано соответствующее 

сообщение. В этом случае необходимо вернуться в программу Gambit, найти 

ошибку и исправить её. 

2.2.3 Масштабирование конечно-элементной сетки 

Размеры расчетных моделей в программе Fluent должны быть 

обязательно заданы в метрах. Построение же моделей удобнее проводить в 

миллиметрах. Рассматриваемая модель цилиндра была создана в 

миллиметрах. Поэтому построенную сетку нужно уменьшить в 1000 раз. Для 

этого в программе есть удобная команда масштабирования Scale Mesh 

(рисунок 19). Она вызывается из главного меню командой: 

Mesh → Scale. 

 

Рисунок 19 – Меню Scale Mesh 



В поле Domain Extents меню приведены максимальные координаты 

модели. Поскольку она создана в миллиметрах, то до масштабирования эти 

цифры запредельны. 

В меню Scale Mesh в поле Mesh was created in (сетка была создана в ...) 

нужно выбрать миллиметры mm (или другую единицу измерения, в которой 

была создана расчетная модель), а затем нажать кнопку Scale. Модель будет 

автоматически промасштабирована. Следует обратить внимание на то, что в 

поле Domain Extents размеры модели примут правильные значения. Отменить 

масштабирование в случае ошибки можно с помощью кнопки Unscale. После 

завершения операции меню необходимо закрыть с помощью кнопки Close. 

2.2.4 Просмотр конечно-элементной сетки 

Конечно-элементная сетка отображается автоматически в главном окне 

программы Fluent, для дополнительных опций просмотра можно вызвать 

меню Mesh Display. 

Display → Mesh. 

 

Рисунок 20 – Меню Mesh Display 

В появившемся меню Mesh Display (рисунок 20) в окне Surfaces 

требуется выбрать все граничные поверхности, которые пользователь хочет 

просмотреть. Следует обратить внимание на то, что имена в списке 



совпадают с именами граничных условий, заданных в Gambit. Для просмотра 

выбранных элементов сетки нужно нажать кнопку Display. 

В результате выполнения команды появится графическое окно, в 

котором будет изображена расчетная сетка или выбранные элементы модели 

(рисунок 21). 

 

Рисунок 21 – Результат отображения расчетной сетки 

Для того чтобы просмотреть конечно-элементную сетку нужно 

использовать мышь. Движение мыши с нажатой левой кнопкой вызывает 

сдвиг модели. Движение мыши с нажатой средней кнопкой вызывает 

появление рамки, с помощью которой можно приблизить (если рамку 

вытягивать слева направо) выделенный фрагмент модели или, наоборот, 

отдалить (если рамку вытягивать справа налево). 

Если в окне Surfaces снять выделение с пункта default – interior, то в 

окне можно будет увидеть только контур модели, без расчетной сетки. 

2.2.5 Задание опций решателя 

В качестве первого действия при описании расчетной модели следует 

выбрать решатель, с помощью которого будет проводиться решение, а также 



определить стационарность или нестационарность задачи. Этот выбор 

осуществляется с помощью команды General: Define → General. 

 

Рисунок 22 – Меню General 

В меню General (рисунок 22) нужно обратить внимание на следующие 

пункты. 

В поле Solver следует выбрать алгоритм решения. Программа Fluent 

позволяет использовать два алгоритма: Pressure Based (в российской 

литературе его называют алгоритмом установления) или Density Based (в 

российской литературе - алгоритм расщепления). Первый из них изначально 

разрабатывался для низкоскоростных потоков, но впоследствии был 

модифицирован и распространен и на другие течения. Алгоритм 

установления создавался для расчетов высокоскоростных транс- и 

сверхзвуковых потоков. Для решения рассматриваемой задачи целесообразно 

выбрать Pressure Based. 

В поле 2D Space выбирается тип задачи: 

Axisymmetric – осесимметричная; 

Axisymmetric Swirl – осесимметричная с вращением; 

Planar - плоская. 

В поле Time описывается, будет ли решение стационарным Steady или 

нестационарная Transient. То есть, будут ли параметры потока зависеть от 

времени или нет. 

Рассматриваемая задача является плоской (Planar) нестационарной 

(Transient). 



2.2.6 Учет в расчете уравнения энергии 

При решении данной задачи нужно учитывать изменение температуры 

потока и тепловые явления (теплообмен и теплопередачу). Для этого 

необходимо включить к решению уравнение энергии с помощью команды: 

Define → Models → Energy. 

В появившемся окне (рисунок 23) нужно поставить галочку в строке 

Energy Equation и нажать ОК. 

 

Рисунок 23 - Меню включения уравнения энергии (Energy) 

2.2.7 Определение модели турбулентности 

Для задания модели турбулентности необходимо выбрать команду: 

Define → Models → Viscous. 

В появившемся списке моделей (рисунок 24) турбулентности нужно 

выбрать модель турбулентности k-ε (k-epsilon). В появившемся меню 

отмечается модель Standard. 



 

Рисунок 24 – Модели турбулентности 

2.2.8 Задание свойств рабочего тела 

Задание свойств рабочего тела осуществляется в меню Materials 

(рисунок 25), которое вызывается командой: 

Define → Materials. 

В рассматриваемой задаче в качестве рабочего тела используется воздух. 

Он установлен в программе Fluent по умолчанию. При решении задач 

течения газов обязательно нужно учитывать сжимаемость рабочего тела. 

Поэтому следует задать зависимость плотности газа от параметров потока. 

Чаще всего для этого пользуются уравнением состояния идеального газа 

(Менделеева – Клайперона). 

Для того чтобы осуществить эту установку, в меню Materials в списке 

Density нужно выбрать пункт Ideal-gas. 



 

Рисунок 25 – Меню Materials 

Для сохранения изменения свойств рабочего тела необходимо нажать 

кнопку Change/Create. После завершения операции меню необходимо 

закрыть с помощью кнопки Close. 

2.2.9 Задание справочного давления 

Особенность программы Fluent состоит в том, что давление, получаемое 

и задаваемое в расчете, является избыточным. То есть для того, чтобы 

получить истинное значение давления необходимо прибавить к нему так 

называемое «справочное давление». По умолчанию в его качестве 

используется атмосферное давление в САУ – 101325Па. Если в качестве 

«справочного давления» принять 0, то результаты расчета и исходные 

данные будут задаваться в абсолютных значениях. Изменить значение 

«справочного давления» можно в меню, которое появится в результате 

выполнения команды: 

Define → Operating Condition. 

Справочное давление в данной задаче составляет 101325 Па. 



2.2.10 Задание граничных условий 

Меню задания граничных условий (рисунок 26) вызывается командой: 

Define → Boundary Condition. 

В поле Zone находится список всех граничных условий, определенных в 

Gambit. Если выбрать имя одного из них, например, dno, то в окне Type будет 

указан тип граничного условия. В случае необходимости в этом окне тип 

граничных условий можно поменять. 

 

Рисунок 26 – Меню Boundary Condition 

Чтобы приступить к заданию граничных условий, необходимо в окне 

Zone выбрать нужное граничное условие, убедиться, что в окне Type тип 

граничного условия указан верно и нажать Edit.... В рассматриваемой задаче 

будут заданы следующие условия: 

- температура всех стенок камера задается равной 293 К, на рисунке 27 

показан пример задания температуры на стенке под именем dno. 



 

Рисунок 27 – Меню задания температуры стенки 

2.2.11. Настройка параметров движения сетки 

Задание динамической модели движения сетки и её основных 

параметров (рисунок 28) осуществляется следующим образом: 

Define → Dynamic Mesh. 

При этом выполняется следующая последовательность действий: 

- устанавливается галочка перед Dynamic Mesh; 

- выбирается тип перестройки Layering параметров сетки во время ее 

движения. Для этого устанавливается галочка перед Layering; 

- активизируется опция In-Cylinder. 

Задание опции In-Cylinder позволяет использовать учет дополнительных 

условий, таких как движение поршня. 



 

Рисунок 28 – Меню динамической сетки (Dynamic Mesh) 

- после этого следует нажать опцию Settings… в разделе Mesh Methods; 

- выполняется настройка параметров для схемы движения расчетной 

сетки Layering (рисунок 29): 

 

Рисунок 29 – Параметры движения расчетной сетки Layering 

- для подтверждения всех введенных параметров следует нажать 

кнопку ОК. 

- активизируется опция in-Cylinder в разделе Options. В ней задаются 

параметры, указанные на рисунке 30 (или параметры моделируемого Вами 

цилиндра). Модель In-Cylinder обычно используется при моделировании 

процессов в ДВС. Это облегчает задачи моделирования движения поршня. 

Здесь Crank Shaft Speed – частота вращения коленчатого вала (об/мин.), 



Starting Crank Angle – начальный угол поворота коленчатого вала, 

Crank Period – время цикла в градусах, Crank Angle Step Size– угол поворота 

коленчатого вала за один шаг, Piston Stroke– ход поршня в метрах, 

Connecting Rod Length – длина шатуна в метрах. 

- после установки всех параметров движения поршня в двигателе 

следует нажать кнопку ОК. 

 

Рисунок 30 – Меню параметров настройки движения поршня (In-Cylinder Settings) 

- после этого вводятся параметры движения поршня. Для этого 

выполняется следующая последовательность действий: 

Define → Dynamic Mesh. 

- активизируется опция Create/Edit нажатием соответствующей кнопки 

под окном Dynamic Mesh Zones; 

- осуществляется задание параметров области piston (рисунок 31): 

 cначала выбирается область piston в выпадающем списке Zone 

Names. 

 выбирается опция Rigid Body в списке Type. 

 Задается направление движения по оси Х равное -1. 



Затем необходимо войти в раздел Meshing Options, в котором 

выполняются следующие манипуляции (рисунок 32). 

 

Рисунок 31 – Меню задания параметров зоны сетки piston 

 

Рисунок 32 – Меню Meshing Options 

2.2.12 Предварительный просмотр движения сетки 

Для выполнения дальнейших действий необходимо сохранить файл 

(Cylinder.cas). 

File → Write → Case. 



При этом следует убедиться, что сохранены все изменения до вывода 

сетки на экран. 

Затем необходимо вывести сетку на экран с помощью следующих 

действий: 

Display → Mesh. 

- выбираются все поверхности из списка Surfaces; 

- затем нажимается клавиша Display; 

- после этого следует закрыть окно Mesh Display. 

Для настройки параметров предварительного просмотра сетки 

(рисунок 33) выполняется следующие действия: 

Define → Dynamic Mesh → Preview Mesh Motion. 

 

Рисунок 33 – Меню предварительного просмотра движения сетки (Mesh Motion) 

В строке Number of Time Steps следует ввести число 360. Данное 

значение обеспечит перемещение поршня вправо. 

После этого выполняется предварительный просмотр движения сетки. 

Для этого нажимается кнопка Preview. Во время, когда происходит 

обновление сетки программой Fluent, в дополнительном окне появляется 

сообщение, показывающее процесс его выполнения. 

После этого следует закрыть окно Mesh Motion. 

2.2.13 Настройка начальных параметров модели 

Для выполнения данной настройки процесса моделирования следует 

открыть файл Cylinder.cas 

File → Read → Case. 



При этом откроется информационное диалоговое окно: «Имеющиеся 

характеристики материалов и методы должны быть сохранены. Чтобы 

продолжить убедитесь в правильности имеющихся значений» (Available 

material properties or methods have changed. Please confirm the property values 

before continuing). 

Необходимо нажать кнопку ОК, для того чтобы закрыть это окно. 

После следует установить параметры (рисунок 34), выбрав: 

Solve → Control. 

 

Рисунок 34 – Меню Solution Control 

Затем следует установить параметры начальных условий для области 

потока с помощью процесса инициализации процесса решения (рисунок 35): 

Solve → Initialization. 



 

Рисунок 35 – Меню инициализации решателя 

При этом выполняются следующие действия: 

- в строке Gauge Pressure вводится значение «101325». 

- в строке X Velosity вводится значение «0». 

- в строке Y Velosity вводится значение «0». 

- в строке Turbulent Kinetic Energy вводится значение «1». 

- в строке Turbulent Dissipation Rate вводится значение «1». 

- в строке Temperature вводится значение «293». 

- затем следует нажать клавишу Initialize. 

2.2.14 Настройка процесса создания анимации 

1. После этого следует произвести настройку процесса создания 

анимации. Данный процесс осуществляется следующим образом: 

Solve → Calculation Activities. 

- сначала следует нажать кнопку Create/Edit в окне Solution Animations. 



- в данном окне в опцию Animation Sequences следует ввести количество 

анимаций, которое будет создано в процессе решения. В данном случае оно 

будет равно числу 2 (рисунок 36). 

 

Рисунок 36 – Меню задания анимации (Solution Animations) 

В первой строчке вводится имя pressure. 

- во вкладке When устанавливается параметр Time Step; 

- затем нажимается кнопка Define; 

- в появившемся окне (рисунок 37) необходимо ввести 2 в число окон 

(Window) и нажать клавишу Set; 

- в опции типа отображений расчетных данных Display Type следует 

выбрать Contours. Затем следует нажать для последующей настройки 

клавишу Edit. 

 

Рисунок 37 – Меню параметров анимации (Animation Sequences) 



- в появившемся окне (рисунок 38) необходимо установить следующие 

параметры. 

 

Рисунок 38 – Меню настройки полей распределения давления (Contours) 

Затем следует нажать кнопку Display и закрыть окно настройки, нажав 

для этого клавишу Close. 

- после этого следует нажать клавишу OK в окне Animation Sequence; 

- затем во второй строчке в окне Solution Animations вводится имя 

следующей анимации Temperature; 

- во вкладке When устанавливается тип записи Time Step; 

- после этого следует нажать кнопку Define; 

- в появившемся окне ввести число 3 в опцию Window. В окно №3 будет 

происходить запись анимации изменения температуры. После выполнения 

данного действия следует нажать кнопку Set. 

- в опции вида отображения расчетных данных Display Type следует 

выбрать Contours (рисунок 39). После этого следует нажать для 

последующей настройки клавишу Edit. 



 

Рисунок 39 – Меню параметров анимации 

В появившемся окне (рисунок 40) во вкладке Contours of следует 

выбрать Temperature и Total Temperature. 

 

Рисунок 40 – Меню настройки полей распределения температуры (Contours) 

- после этого следует нажать Display и закрыть окно, нажав кнопку 

Close; 

- для подтверждения всех введенных значений и настроек нажимается 

кнопка OK в окне Animation. 



Для того чтобы вывести на экран результаты вычислений, следует 

выполнить следующие действия: 

Solve → Monitors → Residual. 

При этом в данном окне последовательно выполняются следующие 

настройки (рисунок 41): 

- в поле Option необходимо поставить галочки напротив слов Plot и 

Print. Это приведет к тому, что невязки по всем уравнениям будут печататься 

в окне сообщения (Print) и отображаться в виде графиков в графическом окне 

(Plot). 

- вводится значение 1000 в строке Iterations to Plot; 

- после этого нажимается клавиша OK и закрывается окно Residual 

Monitors. 

 

Рисунок 41 – Меню настройки результатов вычисления (Residual Monitors) 

2.2.15 Запуск решения задачи 

Для запуска решения задачи следует выбрать следующую команду: 

Solve → Run Calculation. 

В меню Run Calculation (рисунок 42) выполняются следующие действия: 

- в строке Number of Time Steps выбирается количество шагов расчета, 

равное 360; 



- в строку Max Iterations per Time Step вводится максимальное 

количество итераций на один шаг расчета. В данном случае рекомендуется 

ввести число 20 для данного параметра; 

- после этого нажатием клавиши Calculate запускается расчет процессов 

внутри камеры. 

 

Рисунок 42 – Меню задания процесса решения (Run Calculation) 

2.2.16. Сохранение анимации 

Данная процедура выполняется в следующей последовательности: 

Display → Graphics and Animations. 

- в окне Animations выбирается опция Solution Animation Playback и 

нажимается Set Up; 

- в появившемся окне (рисунок 43) выбирается какой-либо 

термодинамический параметр, например, Pressure; 

- в опции Write/Record Format выбирается тип файла MPEG. 



 

Рисунок 43 – Меню работы с анимацией 

- для того чтобы запустить процесс сохранения следует нажать кнопку 

Write. 

- затем следует закрыть данное окно, нажав кнопку Close. 

2.2.17 Просмотр результатов расчета 

Картина распределения температуры после процесса сжатия газа 

показана на рисунке 44. 

 

Рисунок 44 – Распределение температуры после процесса сжатия 

Результат расчета давления в конце процесса показан на рисунке 45. 



 

Рисунок 45 – Распределение температуры после процесса сжатия 

Давление в конце процесса сжатия составило P2п=187 кПа. 

2.2.18 Определение показателя политропы и работы сжатия 

Запишем равенство 
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Значение давления берем равное атмосферному, P1=101325 Па. Значение 

объёмов вычисляем исходя из геометрических параметров модели. Далее 

производится расчет работы сжатия для политропного процесса: 
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3 РАСЧЕТ ПРОЦЕССА РАСШИРЕНИЯ ГАЗА 

В ПРОГРАММНОМ ПАКЕТЕ FLUENT 

3.1 Создание расчетной модели 

Построение расчетной модели в Gambit осуществляется аналогичным 

образом, как рассмотрено в пункте 2 данного пособия. 

Модели присваивается имя MODEL 2. Данная модель представляет 

собой объём, заключенный между торцовой стенкой цилиндра и поршнем, 

находящимся в крайнем правом положении, после процесса сжатия газа. 

Здесь будут приведены лишь те пункты создания и настройки модели, 

которые отличаются от предыдущего расчета в пункте 2 «РАСЧЕТ 

ПРОЦЕССА РАСШИРЕНИЯ ГАЗА В ПРОГРАММНОМ ПАКЕТЕ 

FLUENT». 

3.1.1 Построение базовых точек 

Построение базовых точек осуществляется по координатам, указанным в 

таблице 3. 

Таблица 3 – Координаты точек профиля модели 

Номер точки № Координата X, мм Координата Y, мм Координата Z, мм 

1 0 0 0 

2 10 0 0 

3 10 130 0 

4 0 130 0 

Результат построения изображен на рисунке 46. 



 

Рисунок 46 – Построение базовых точек профиля 

3.1.2 Построение контура профиля 

Профиль модели образован четырьмя отрезками. Необходимо 

последовательно соединить все точки профиля прямыми. Результат действия 

показан на рисунке 47. 

 

Рисунок 47 – Построение контура профиля модели 



3.1.3 Построение и просмотр поверхности построенной модели 

Основой для построения конечно-элементной сетки двухмерной модели 

является поверхность. Для того чтобы убедиться, что операция построения 

поверхностей или объемов прошла удачно, необходимо скрыть невидимые 

линии. Для этого нужно нажать кнопку  в меню управления видами. 

Результат выполнения представлен на рисунке 48. 

 

Рисунок 48 – Результат построения поверхности 

3.1.4 Указание граничных поверхностей 

В программе Gambit осуществляется предварительное указание 

граничных условий. 

В данной решаемой задаче типы граничных условий одинаковы и 

выбираются типом Wall; названия граничных условий следующие: отрезок 

слева – PISTON 1; отрезки сверху и снизу – STENKA 1; справа – DNO 1. 

3.1.5 Построение конечно-элементной сетки 

Настройки сетки остаются такими же, как и в предыдущем случае. 



Результат построения упорядоченной четырехугольной сетки приведен 

на рисунке 49. 

 

Рисунок 49 - Результат построения четырехугольной неструктурированной 

конечно-элементной сетки 

3.1.6 Передача построенной расчетной модели во Fluent 

Для экспорта созданной модели в верхнем меню нужно выбрать 

следующие пункты:  

File → Export → Mesh. 

В появившемся окне нужно ввести имя файла обмена. По умолчанию 

оно совпадает с именем файла модели (например, MODEL 2.msh). С 

помощью кнопки Browse можно выбрать место, где файл необходимо 

сохранить. Поскольку расчетная модель двухмерная, то обязательно следует 

нажать кнопку Export 2D (X-Y) Mesh. Запись файла обмена подтверждается 

нажатием кнопки Accept. Если файл обмена был успешно записан, то в окне 

сообщений появится надпись Mesh was successfully written to <имя 

файла>.msh. 

В указанном месте появится файл <имя файла>.msh. 



3.1.7 Сохранение модели Gambit 

Сохранение модели Gambit для редактирования или каких-то других 

действий производится с помощью команды: 

File → Save. 

3.1.8 Закрытие программы Gambit 

Закрытие программы Gambit осуществляется командой: 

File → Exit. 

3.2 Настройка расчета в программе Fluent 

Настройка расчета в программе Fluent осуществляется аналогично, как и 

для предыдущего расчета за исключением некоторых моментов, которые 

приведены ниже. 

3.2.1 Настройка параметров движения сетки 

Задание динамической модели движения сетки и её основных 

параметров (рисунок 50) осуществляется следующим образом: 

Define → Dynamic Mesh. 

При этом выполняется следующая последовательность действий: 

- устанавливается галочка перед Dynamic Mesh; 

- выбирается тип перестройки Layering параметров сетки во время ее 

движения. Для этого устанавливается галочка перед Layering; 

- активизируется опция In-Cylinder. 

Задание опции In-Cylinder позволяет использовать учет дополнительных 

условий, таких как движение поршня. 



 

Рисунок 50 – Меню динамической сетки (Dynamic Mesh) 

- после этого следует нажать опцию Settings… в разделе Mesh Methods; 

- выполняется настройка параметров для схемы движения расчетной 

сетки Layering (рисунок 51): 

 

Рисунок 51 – Параметры движения расчетной сетки Layering 

- для подтверждения всех введенных параметров следует нажать 

кнопку ОК; 

- активизируется опция in-Cylinder в разделе Options. В ней задаются 

параметры, указанные на рисунке 52 (или параметры моделируемого Вами 

цилиндра); 

- после установки всех параметров движения поршня в двигателе 

следует нажать кнопку ОК. 



 

Рисунок 52 – Меню параметров настройки движения поршня (In-Cylinder Settings) 

- после этого вводятся параметры движения поршня. Для этого 

выполняется следующая последовательность действий: 

Define → Dynamic Mesh. 

- активизируется опция Create/Edit нажатием соответствующей кнопки 

под окном Dynamic Mesh Zones; 

- осуществляется задание параметров области piston (рисунок 53): 

 cначала выбирается область piston в выпадающем списке Zone 

Names. 

 выбирается опция Rigid Body в списке Type. 

 Задается направление движения по оси Х равное 1. 

Затем необходимо войти в раздел Meshing Options, в котором 

выполняются следующие манипуляции (рисунок 54). 



 

Рисунок 53 – Меню задания параметров зоны сетки piston 

 

Рисунок 54 – Меню Meshing Options 

3.2.2 Настройка начальных параметров модели 

Необходимо установить параметры (рисунок 55), выбрав: 

Solve → Control. 



 

Рисунок 55 – Меню Solution Control 

Затем следует установить параметры начальных условий с помощью 

процесса инициализации процесса решения (рисунок 56): 

Solve → Initialization. 

 

Рисунок 56 – Меню инициализации решателя 



При этом выполняются следующие действия: 

- в строке Gauge Pressure вводится значение «188000». 

- в строке X Velosity вводится значение «0». 

- в строке Y Velosity вводится значение «0». 

- в строке Turbulent Kinetic Energy вводится значение «1». 

- в строке Turbulent Dissipation Rate вводится значение «1». 

- в строке Temperature вводится значение «293». 

- затем следует нажать клавишу Initialize. 

3.2.3 Запуск решения задачи 

Для запуска решения задачи следует выбрать следующую команду: 

Solve → Run Calculation. 

В меню Run Calculation (рисунок 57) выполняются следующие действия: 

- в строке Number of Time Steps выбирается количество шагов расчета, 

равное 360; 

- в строку Max Iterations per Time Step вводится максимальное 

количество итераций на один шаг расчета. В данном случае рекомендуется 

ввести число 20 для данного параметра; 

- после этого нажатием клавиши Calculate запускается расчет процессов 

внутри камеры. 



 

Рисунок 57 – Меню задания процесса решения (Run Calculation) 

3.2.4 Сохранение анимации 

Данная процедура выполняется в следующей последовательности: 

Display → Graphics and Animations. 

- в окне Animations выбирается опция Solution Animation Playback и 

нажимается Set Up; 

- в появившемся окне (рисунок 58) выбирается какой-либо 

термодинамический параметр, например Pressure; 

- в опции Write/Record Format выбирается тип файла MPEG. 



 

Рисунок 58 – Меню работы с анимацией 

- для того чтобы запустить процесс сохранения следует нажать кнопку 

Write. 

- затем следует закрыть данное окно, нажав кнопку Close. 

3.2.5 Просмотр результатов расчета 

Результат расчета давления в конце процесса показан на рисунке 59. 

 

Рисунок 59 – Распределение давления после процесса расширения 

Так как процесс расширения был изотермический, то значение 

температуры оставалось неизменным (рисунок 60). 



 

Рисунок 60 – Распределение температуры после процесса расширения 

3.2.6 Определение показателя политропы и работы расширения 

Значение n для изотермы расширения равно: 
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Работа сжатия газа (в Дж) для изотермического процесса: 
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